
 

Resizing parametric designs 

 

 

Task 

In this exercise, you will learn how to load a folding box from the EngView Library of Resizable Designs, 
and then how to modify it. 

 

Folding box: EVF 11001 Reverse Regular Tuck Lock 

Folder: EngViewWork5\Standards Library\MM\ 

Standards\Folding Carton\EngView Standards\ 

EVF1 Glued Boxes\EVF11 Rectangular\ 

EVF110 Tuck Lock - Tuck Lock\ 

EVF11001 Reverse Regular Tuck Lock.evr 

Width: 78 mm 

Depth: 58 mm 

Height: 123 mm 
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Complete folding box       
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Exercise description 

EngView Package Designer offers a set of libraries with resizable designs for the materials folding carton, 
corrugated board and Inverted Corrugated Board. In this exercise, you will learn how to load a standard 
design for carton board and modify it according to your needs. 

IMPORTANT: You can open resizable designs while browsing the Library Index. In the Index, the 
resizable designs are presented as 2D drawings in pages by groups.  

To access the Library Index, on the Start menu, point to EngView Systems | Package Designer Suite | 
Library Index. 

To use a standard from the Library Index, choose its 2D drawing. A new page appears with information 

about the selected drawing. Then click the  button.  

The design opens automatically in Package Designer. 

An alternative way of opening a resizable design is described in the procedure that follows. 

1. To load a design from the standards library, do any of the following:  

• On the File menu, click New. 

• In the toolbar, click New Project . 

The Material dialog box opens. 
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2. To load a standard design, click From Resizable Design. 

3. In the Project Properties area, type a name for the project and, optionally, a title, a text describing 
what the project is about, and who creates the project. 

4. In the Material area, select material properties, base type and name. The properties Type and 
Thickness are loaded automatically.  

IMPORTANT: Make sure that in Base type you select the material that you want to work with — folding 
carton, corrugated board, ICB, and then select a resizable design from the same group. For example, if 
you want to work with folding carton, choose a resizable design from the Folding Carton Cardboard 
section. Pay attention, however, that if in this case you select a resizable design from the Corrugated 
section, the parameters that the program will use for computing the design will not be computed. For an 
example of this error, see the picture below. 

The highlighted rows show the parameters that cannot be computed due to the mismatch of the selected 
project material (folding carton) and the predefined material of the selected resizable design (corrugated 
board). 
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5. Click Next. 

The Resizable design dialog box opens. 
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6. In Look in, browse to EngViewWork5\Standards Library\MM\Standards\Folding Carton\EngView 
Standards\EVF1 Glued Boxes\EVF11 Rectangular\EVF110 Tuck Lock – Tuck Lock, and select the file 
EVF11001 Reverse Regular Tuck Lock.evr. 

TIP: If you know the name of the file you’re looking for, you can type it in Search. The 
program then lists all the files whose names contain the text you’ve entered. There are two 

search modes — (1) for searching in the current folder and (2) the Toggle Flat Mode  is 
for searching in the subdirectories. 
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Use the dropdown list of the preview area to switch between the file’s 2D and 3D previews, use the down 
arrow above the preview area. 
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7. To open the design, click Finish. 

The design opens in a new window. 
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 TIP: If the dimensions are not automatically displayed and you need them, do any of the following:  

• On the Tools menu, click Options, and then switch to the View tab. In the Show group, select 
Dimensions. 

• In the working area, right-click, and then select Show Dimensions on the context menu. 
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OR 

 

TIP: To fit the window to the size of the program, do any of the following: 

• Double-click the design’s title bar. 

• Click the Maximize button. 
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NOTES: 

• The work area is divided into two parts: a tabular area (at the right-hand side) and a graphical 
area, where the design is displayed. You can show or hide the tabular area by clicking the 
Show/Hide button , which is visible in the lower bottom right corner below the graphical area. 

• There is a dependence between the parameters in the table and the dimensions in the drawing. 

8. In the tabular area, double-click a parameter (in the Name column) in the Parameters tab. An 
animation is played out of the available dependencies between the selected parameter and other 
parameters in the design. Thus you can see which dimensions will be affected and how the design will 
resize if the value of this parameter is changed. 

9. Edit the Length of the Box by changing the Expression of parameter A to 78. 

10. Press TAB or ENTER. 

The drawing is resized in accordance with the new value. Also the dimension values in the design are 
automatically adjusted. 
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11. Edit the width of the box by changing the expression of B to 58. Edit the height of the design by 
entering 128 in the Expression field of parameter H. 
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  NOTE: In the Expression column, you can enter the name of another parameter. If you enter a 
parameter, the actual value is automatically calculated in the Value column. 

For example, if you want to create a cube, in the Expression column enter a numerical value for the 
parameter A. For parameters B and H, you should enter parameter A in the Expression field (see below). 
The actual values of B and H would then be displayed as numeric values in the Value column. That is, if 
you want to resize the folding box you would have to change only the value of parameter A. The values 
of B and H would then automatically adapt. 

The parameters in the Parameters tab are ordered hierarchically. If in the Expression field of a 
parameter you want to enter another parameter, the latter must be predefined and already listed above 
the parameter you want to express it with. For example, you can express B and H with parameter A, 
because parameter A has been defined above B and H. 
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The new entries cause the tuck-in flaps and dust flaps to adapt automatically, because the parameter PH 
is linked to the parameter B. 

 

12. To save the file, on the File menu, click Save as, and then save the file as an EVD file. 
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Modifying Parametric Designs 
 

 

 

 

Task 

In this exercise, you will learn how to modify a folding box from a resizable design. You will do this by 
removing the flaps and the tuck-in flaps on the top and replacing them with a compound component 
from the Synergy Components library. 

Folding box: A60.45.00.01 Auto Closure – Winged Flap Closure with Dustproof Flap 

Folder: EngViewWork5\Standards Library \MM\ 

Standards\Folding Carton\ECMA \ 

Long Seam Rectangular\ 

A60.45.00.01 Auto Closure – Winged Flap Closure with Dustproof Flap.evr 

Width: 160 mm 

Depth: 75 mm 

Height: 128 mm 

Components: Compound Components/Regular Tucks/Friction Tuck 1a 

Compound Components/Tongue Locking Systems/Tongue Locking System 01a 

1 
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Complete folding box 
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Exercise description 

 1. Open the file that you want to work with. (For the purposes of this exercise, A60.45.00.01 Auto 
Closure – Winged Flap Closure with Dustproof Flap.evr.) 

 

2. Resize the design: A= 160; B=75; H=128. 
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3. On the File menu, click Save as, and save the file under the name Exercise2.evd in the predefined 
folder (EVD). 

 

Deleting components. Replacing components 

In this part of the exercise we are going to modify the resizable design. We will remove the top 
components and replace them with a compound component, which we load from the Synergy 
Components library. 

1. On the toolbar, click Select . 

A subset of two buttons appears in the toolbar – Select with Intersect  and Select Outside 

Objects .  Choose the Select outside Objects button  and deactivate the Select with 
Intersect button. 

NOTE: In this example, the inverse selection is used to make sure that the entire upper part of the 
design will be removed. Because of a constructional particularity in the design’s upper right-hand region, 
the use of the standard method of selecting will not remove the whole of the upper part. 

2. To select using the outside objects mode, draw a rectangle around that part of the design that you 
don’t want to be selected. When you click with the mouse the system will highlight in magenta the parts 
outside the selection rectangle: 
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3. To delete the selected objects, do any of the following: 

• Right-click a blank area in the graphical area, and then click Delete on the context menu. 

• On the Edit menu, click Delete. 

• Press CTRL and DELETE. 

  

The program deletes only the selected components: 

 

4.  In the tabular area, click the Synergy Components tab. 
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5. In the upper part of the tabular area, click the Synergy Components drop-down menu. The Synergy 
Components tree appears with all subfolders containing the bases and components that you can use. 

 

6. In the tree, go to Compound Components  > Regular Tucks to display the contents of the folder. The 
program lists all components and parts in the selected folder. 
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7. In the preview pane on the right, select the Friction Tuck 1a component, and then drag it to the 
graphical area. 

 

 NOTE: When you drag a component to the graphical area, the program activates three modes – 

Horizontal Mirror  , Vertical Mirror   and Component Parameters  (see picture above). The 
components from the Synergy library can be attached to any base. Sometimes, however, you need to 
mirror a component to be able to attach it to the base correctly and create a valid design. In this case we 

use the Horizontal Mirror   or the Vertical Mirror   buttons. 

The Component Parameters button (  ) is used to display the Component Parameters dialog box if 
you need to see or edit parameter expressions. 

8. Click the Vertical Mirror   to mirror the component Friction Tuck 1a.  
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9. Start attaching the mirrored compound component to the base from right to left. Position the first 
active point of the component on the first point of the base (pictured). 
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10. Position the second active point on the first folding line and click to attach the point. Position the rest 
of the active points in the same way, finishing in the left base corner: 

 

After you have attached the last point of the component, the Component Parameters dialog opens 
automatically. Note that the parameters AX2 and AX3 have extracted the values of the distances that 
form during the clicks we made. Owing to this, the new top component has resized according to the 
base.  
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Notice that the height of Tuck-In — PH — is computed in relation to the parameter AX3. 

11. To confirm the values, click OK. 

 The component is now attached to and resized according to the design. 
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12. Save the changes to the file. 

Linking compound component parameters to those of the base 

Linking is necessary to enable the recomputation of the parameters of the compound component after 
we have edited the main parameters of the base.  

NOTE ON COMPONENTS’ STRUCTURE 

Boxes are constructed by attaching compound components to a base. To ensure that the relations 
between a compound component and its base are correct, a set of auxiliary system parameters — 
called AX parameters — are used (AX1, AX2, AX3 …). These guarantee that once attached to the 
base, compound components will be correctly computed according to the base to which it is attached. 
The AX parameters are part of the compound component and are associated with the distances 
between its control points. Owing to this association, when a compound component is being attached to 
a base by means of its control points, the values of the component's AX parameters adopt the values of 
the main distances in the base. 

 

IMPORTANT: If you choose to resize this design, the width and the length of the components that were 
added later are automatically adapted to the new size, because the control points of the component 
were attached to the base. However, the height of the tuck-in flap (PH) will not adjust to the resized 
design. That is due to the fact that the parameter PH was computed according the value of AX3 during 
the attachment. Consider the following example: 

In the tabular area, in the Parameters tab, change the values of A and B to 130 and 100, respectively. 
Notice that the height of the panel remains as it was predefined while attaching it to the base (see the 
image below). This is because AX2 and AX3 are defined by numbers and not by parameters and are 
unconnected to the design’s main parameters. 
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Despite our changing the value of parameter B to 100, the AX3 parameter has kept the value it had 
during the attachment (75). 

Using system parameters to allow recomputing after changes in the base 
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To ensure that each time the base is being edited, the compound component will be automatically 
recomputed and the changes in the base are duly reflected, we must create dependencies between the 
auxiliary system parameters of the compound component (AX2, AX3) and the parameters of the base. 

1. Delete the Friction Tuck and then re-attach it.  

2. After you have attached the last point of the component, the Component Parameters dialog box 
opens. 

Now the parameters AX2 and AX3 have the values of the current size of the box, 130 and 100, 
respectively. The parameter PH has recomputed and is now 99.5 mm.   

 
To link the compound component and the base, you must substitute the expressions of AX2 and AX3 
with the base’s parameters A and B, respectively. In this way the size of the panel (PH) is made 
dependent on the size of the base when resizing the design. 

 

4. Click OK, and then resize the design by changing the values of A and B to 160 and 75, respectively. 
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5. The height of the panel (PH) has now adjusted to the resized design because the parameter AX3, 
which takes part in the expression of PH, has been made dependent on the parameter defining the 
base (B). 
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Attaching and editing compound components 

IMPORTANT: Compound components are made up of several individual components. Often distances 
in one individual component are dependent on distances in another individual component in the same 

compound component. This dependence is represented in the parameter expressions. For example, in 

the compound component Tongue Locking System 01a, the distance (parameter) TTHL1 depends on 
the distance (parameter) TTW in the second individual component. 

If during attaching we change the values of TTW, then the value of TTHL1 will be automatically 
recalculated. 

 
 

The example that follows explains the editing of the compound components and concludes the 
procedure. 

1. In the Synergy Components tab, click Compound Components, and then click the Tongue Locking 
Systems. Then select the Tongue Locking System 01a (pictured). 
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2. Begin dragging the component into the graphical area and click the Vertical Mirror button on the 
contextual edit bar to reverse the component’s vertical direction (pictured). 
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3. Attach the component to the points shown as shown in the following picture. 
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The Component Parameters dialog box appears. 

 

4. Make the dimension TTW=60, and then click Apply. 

The distance TTHL1 is also recalculated. 
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NOTE: To see the hidden parameter TTHL1, right-click in the tabular area, and then click Show Hidden 
on the context menu. 

5. Click OK. 

The component is now attached to the base.  

NOTE ON PARAMETER DEPENDENCIES IN COMPOUND COMPONENTS 

Additionally, note that once the compound component has been attached to the base the compound 
component dissolves into individual components which no longer have dependencies between them. If 
we need to edit a distance after the compound component has been attached, the distances in the other 
individual components will not recalculate automatically and must be edited separately.  

As mentioned earlier, the parameter TTW controls also the distance TTHL1 in the other individual 
component (highlight 2 in the picture). Changing the expression of TTW in the first individual component 
(highlight1) is not reflected directly in the parameter TTHL1 – that is why additional editing is necessary 
in the second component (highlight 2). 
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If you choose to change to 50 the value of the TTW dimension in the component 1 (highlight 1), the 
distance TTHL1 in the component 2 (highlight 2) has not changed automatically to 50; it will retain its old 
value – 60. 

6. To edit the value of TTW to 50, double-click component 1. 

The component’s parameters table appears. 

7. Change the expression of the parameter TTW to 50. 
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Changing the value of the parameter TTW automatically changes the value of the parameter TTHL, 
because TTHL belongs to the same individual component. (See the table above.) 

The recalculation, however, is not reflected in the parameter TTHL1 in the component 2 (see the picture 
below). We need to manually edit the value of TTW in the second component. 

8. Double-click the component 2.  

The component’s parameters table appears.  

 

9.  Edit the expression of TTW to 50 
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Notice that the parameter TTHL1 has recomputed. 

10. To close the table, click OK. 

11. On the File menu, click Save As, and then and save the file as an EVD file. 
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Creating a Box from Components 
 

 

 

Task 

In this exercise you will learn how to make a new design from individual components. We will load these 
components from the Synergy Components library and then will add dimensions to the structure.  

Components: Bases/Base (4 panels) 

Compound Components/Regular Tucks/Friction Tuck 2b 

Compound Components/Regular Tucks/Friction Tuck 2a 

Individual Components/Glue Flaps/Glue Flap 1 

Width 58 mm 

Depth 50 mm 

Height 165 mm 

Tuck-in-flap 15 mm 

Dust flap 32.5 mm 

Glue flap 13 mm 
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Complete folding box 
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Exercise description 

You can create new folding box designs from separate components that you can insert from the Tables 
window of the Synergy Components library. 

1. To create a new file, do any of the following: 

• On the File menu, click New. 

• In the toolbar, click the New Project . 

The Material dialog box appears. 

 

2. Create a new blank drawing, click Blank Drawing. 

3. Double-click the title bar of the new project to fit the window to the size of the program. 

4. To show the tabular area, on the View menu, Tables in the menu bar or click the Show/Hide button. 
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5. Click the Synergy Components drop-down menu, and then click the Synergy Components folder. 

You will see its subfolders. 
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6. To create the base element, click the Bases folder. 

A list preview of all available bases appears. 

7. Select the element Base (4 panels). 

A preview of the base appears in the tabular area below the component list. 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

5 
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8. Keep the mouse button pressed and drag the component into the graphical area. 

 

9. When you decide where to place the component, click.  

The Component Parameters dialog box opens. In it, you can specify the values of  parameters of the 
base named X1 to X5 (defining the length of all the panels, as well as the height of the base). 

10. Edit the values according to the picture below: 

X1=49.5 mm (Here the material thickness correction (0.5 mm) is taken into account.) 

NOTE: You can use also the expression 50-d(). It ensures that the thickness correction is up to date each 
time the material thickness is changed. 

X2=58 mm 

X3=50 mm 

X4=58 mm 
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X5=165 mm 

 

 NOTE: Notice that when you are editing a certain parameter in the tabular area and you click a parameter 
in the Expression column, this parameter is highlighted in yellow in the graphical area.  

10. To apply the changed values from the table to the drawing, click OK.  

11. To exit the mode, click ESC. 

The base appears in the graphical area.  
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12. To add the top and the bottom parts, as well as the glue flap, click the Synergy Components drop-
down menu to display the contents of the folder.  

13. Go to Compound Components > Regular Tucks.  

The program lists all components in the selected folder. 
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14. Select Friction Tuck 2b, and drag it into the graphical area.  

15. Start attaching the tuck to the base from left to right: Position the first active point of the compound 
component on the first point of the base, and then click to attach the first panel of the compound 
(pictured). 

 

16. Position the second active point on the first folding line, and then click to attach the point.  

17. Attach the rest of the active points in the same way.  
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18. After you have attached the last point of the component, the Component Parameters dialog box 
opens. You don’t need to edit the parameters, since the values for AX2 and AX3 are automatically 
extracted from the values of the base.  
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 NOTE: During the assembly of a resizable design, compound components are attached to the base by 
their active control points. The distance between these control points are linked to the parameters AX1, 
AX2, AX3, and so on, depending on the number of control points in the compound component. During the 
attachment of the compound component, the distance between the first and the second control points is 
entered as a value in AX1 if there is such a parameter in the compound component. The distance between 
the second and the third control points in AX2, and so on. In the current case, the compound that we use 
has two system parameters – AX2 and AX3. That is why, the values of AX2 and AX3 are automatically 
extracted from the size of the two middle panels of the base. (AX2 and AX3 are the distances between the 
second and the third clicks and between the third and the fourth clicks, respectively.) 

In the case at hand, because the height (PH) of the Tuck-In panel depends on AX3, it will be computed 
correctly. 

 

19. To close the dialog box, click OK. 

The regular tuck is now part of the design: 
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20. To attach the bottom friction tuck, select Friction Tuck 2a from the same folder and drag it into the 
graphical area.  

 

Now you need to mirror the compound component horizontally to be able to attach it correctly on the 
bottom part of the base. 

21. Before attaching the first active point of the component, press the Horizontal Mirror  button from 
the contextual edit bar.  

The component is mirrored.  
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135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

16 



 

22. Start attaching the active points of the component to the base from left to right. Attach all the points of 
the friction tuck in the same way as the top friction tuck. When you have attached the last active point, the 
Component Parameters dialog box will open.  

 

You do not need to make any corrections, because the values for AX2 and AX3 are extracted 
automatically. 

23. To close the dialog box, click OK.  

The bottom tuck-in flap is added to the design. 
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Now we are going to add the glue flap to the right side of the design. 

24. In Synergy Components, select the subfolder Individual Components > Glue Flaps.  

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

18 



 

 

25. Select Glue Flap 1 and drag it into the graphical area. Then attach its first active point to the top right 
control point of the base.  
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26. Attach the second active point of the glue flap. 

The Component Parameters dialog box opens.  

25. Edit the parameter expressions in the following way. 

GL=12 mm 

GLA= 75 mm 

GLA1= 75 mm 
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26. To close the dialog box, press OK.  

27. To exit the mode, press ESC.  

The glue flap is now part of the design. 

 

28. Save the design in the EVD folder. 
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Adding dimensions 

Each component has dimensions, which were set when it was created. In Package Designer, to visualize 
these dimensions while you are inserting the component, right-click the component, point to View, and 
then click Dimensions. 

 

In this exercise, you do not need these dimensions, so it’s best to hide them. 

1. You can set informative dimensions. To insert such dimensions, click the Dimensions tab, which hosts 
several dimensioning tools. 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

22 



 

 

 
Single-object dimension 

 
Associative (two-objects) dimension 

 
Multi-line dimensions 

 
Overall dimensions 

 
Single-object measure tool 

 
Associative (two-objects) measure tool 
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2. To show the drawing’s overall width and height, click Overall Dimensions .  

The two dimensions are visualized in the design. 
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3. To add single dimensions, click Single Object Dimension .  

TIP: Use a single-object dimension for objects such as circles, lines and arcs.  

4. Click the arc of the top tuck-in flap (pictured) and choose where you want to position the dimension.  

 

5. Click again to set the dimension. 
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6. To create dimensions between two objects, click Associative Dimension .  

TIP: This mode is convenient for angles and distances. 

7. Click the right part of the top dust flap (pictured). 
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8. Click the outside cutting line of the dust flap (pictured). 

 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

27 



 

 

9. The angle dimension appears. Hover with the mouse to position it as in the picture below, and click 
again to place it on the design. 
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10. Click Multi-line Dimension . With this tool you create consecutive dimensions between multiple 
parallel lines — for example, the dimensions between several parallel lines. 
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10. Create the first dimension: click the left cutting line of the base (line 1), and then click the first parallel 
crease line (line 2). Then click a blank area between the first and the second crease line (number 3). 

11. To create the next dimension, click line number 4, and then click in a blank area.  

12. Set the rest of the panel dimensions in the base in the same way as in Step 11. 
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NOTE: To get an idea about a dimension, you can use Single Object Measure  and Associative 

Measure . These are modes for informative dimensioning, which set no actual dimension lines. The 

Single Object Measure  displays the dimension of each single object in the design that is hovered 

over with the mouse. The Associative Measure  displays dimensions between two objects or two 
points. With this tool the program always displays dimensions between the last clicked object and the 
object that is hovered over with the mouse. 

 

Editing dimensions 

Deleting a dimension 

1. To delete a dimension, choose the Select tool , right-click a dimension, and then click Delete on 
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the context menu. 
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 NOTES: You can delete dimensions in four more ways: 

 

• To remove all dimensions at once, click Select , then right-click and choose Select > Select 
by Attributes. In the Select Objects dialog box choose the Dimension object from the Type drop-
down menu and click OK.  Right-click a blank area in the graphical area and select Delete or 
press Ctrl + Delete.  

• Go to the Dimensions tab in the Tabular area. Right-click the dimensions you want to delete and 
choose Delete or press Ctrl + Delete.  

• Right-click a dimension and choose Select > By Style. The system will highlight all dimensions 
with this style in magenta. Right-click a blank area and select Delete or press Ctrl + Delete. The 
system will delete all highlighted dimensions.  

• In the tabular area, click the Styles tab, and then click the circle in front of the Dimensions style. 
This selects all the dimensions in the drawing, which can delete. 

  

Moving an existing dimension 

1. To move an existing single dimension, choose the Select tool. Click the dimension you want to move 
and drag it to the new position.  
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2. Click with the mouse to set the dimension on its new place in the design. 

 To center the dimension value along the dimension line click a dimension. Click the Centered text button 

 that appears in the subset of toolbars in the Dimensions tab. The dimension value will stay centered 
along the dimension line when you decide to move the dimension later. The system remembers if we 
click the Centered Text button and applies this mode to all further dimensions that will be set. 

3. Save the file.  

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

34 



 

 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

35 



 

Creating a 3D Representation 

With Package Designer you can create a 3D model for every design. Each file in the Standards Library 
has a predefined 3D model. Each 3D drawing is defined by the folding sequence of the panels that make 
up the design. The 3D model can be rotated and turned, opened and closed directly in Package Designer, 
and can be viewed in solid, transparent or wireframe modes. The program supports 3D PDF export 
compatible with Adobe Reader, version 8.0 or higher.  

Task 

In this exercise we will open a design from the EngView Samples folder. Then we will create a 3D model 
for it, insert an image and export the 3D model as a PDF file. 

Complete folding box and its 3D presentation 
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Exercise description 

1. Open the file Aquafit.evd from the folder C:\EngViewWork5\EngView Samples.  

 

 

Creating a new 3D Presenter drawing 

We will create a 3D model with a folding sequence represented by different steps. Then we will add a 
production phase. 

NOTE: Each 3D model is defined by the sequence of folding of the panels of the design. A folding 
sequence consists of phases (made up of one or more steps), steps (defined by one or more actions) and 
panel actions. In a step, each panel is defined by a separate action. According to the defined steps and 
phases, we can see a preview of the final animation as a result of the created folding sequence. 

1. On the 3D tab, click New 3D Presenter Drawing . 
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A new 3D drawing is automatically created. 

Base panel 

The program automatically selects a base panel, around which the rest of the panels are folded at 90 
degrees. As a result of this, a phase, Usage, is created automatically, in which all panel actions are folded 
at 90 degrees in a single step (Step 1). 

NOTE: While creating the 3D representation you can choose your own base panel, which is different from 

the default one. To do so, click the Set Base Panel button , and then select the panel that you want to 
be the base one. 
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2. To see the final state of the design, in the tabular area click Usage. 

TIP: To switch to transparent mode, click the …. Button. 
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3. To open the Usage phase, click the '+' symbol. 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 



 

 

4. To open Step1, click the '+' sign. A list of actions appears. Then click an action. 

In the graphical area, the respective panel is highlighted in magenta. It is highlighted also in the Panels 
table, where you can easily change the folding angle or the type of panel action, or both.  
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5. To play a predefined action, double-click an action in the tabular area or click Animate Folding Side 

 button on the contextual edit bar.  
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TIPS 

Manually adjusting folding angles 

You can manually adjust a panel’s folding angle: select the panel you want to fold and on the contextual 
edit bar move the slider. While you are operating the slider, the program animates the folding. When 

ready, press the Set Angle button  to the right of the slider; this sets the folding angle for the panel. 

Changing steps’ folding times 

You can also change steps’ folding times. Click the Time column of a step, and then enter a new folding 
time (pictured). The time interval affects all the actions in the step. 
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Inserting a new step to a phase 

1. In the Usage phase, select Step 1 and then open it. In the graphical area, select a panel from the 
bottom lock. This automatically selects the respective panel action in Step 1. 
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2. Drag the selected action — Fold Panel7 — down into the Usage phase. The program automatically 
creates a new step below Step1 and moves the action into it. 
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3. In the same manner, select the panels from the bottom lock one by one and drag them into Step 2.  

TIP: To more easily select a panel, go to the Initial State phase, which displays the entire design unfolded 
and in a single plane. Then click the panel that you want; this automatically highlights in the tabular area 
the corresponding action. Select the highlighted action and drag it to where you want it to be along the 
sequence of actions — in the current case, into Step 2. 
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4. Right-click Step 2, and then click Insert step below on the context menu. The program creates an 
empty Step 3. 
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5. Select Step 1, and then in the graphical area select a panel from the upper lock. The panel will be 
highlighted in Step 1. Drag the panel into Step 3. Repeat the same for all panels from the bottom lock, 
dragging them into Step 3.  
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6. In the tabular area, select Step 1. As the design is folded, in the graphical area position the mouse 

pointer on the glue flap. After 2–3 seconds you will see the bubbles sign , which indicates that there is 
more than one panel at this place. Click and you will see a list of the available panels (pictured). Move the 
mouse over the list. The program will highlight the respective panel.  
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7. Select the glue flap. On the contextual edit bar, in Angle, change its folding angle to 91 degrees or type 
the value in the Parameters column in the Panels table below. (Both options are highlighted in the next 
picture.) 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 



 

 

NOTE: A panel can play a role in more than one step or phase. For example, we may need to fold the 
same panel on two occasions, so we will use it in two different steps. 

For example, we will fold the glue flap in two different steps. In Step 1, leave the glue flap to be folded at 
90 degrees: select the glue flap and in Angle change its folding angle to 90 degrees. In the tabular area, 
select Step 3, and then select the glue flap in the graphical area (if it has remained unselected). On the 
contextual edit bar, in Action, choose the Fold option. Then in Angle type 91. (You can do these actions 
also in the tabular area: respectively, in the Action and Parameters columns in the panels table.) 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 



 

 

NOTE: You can have the same panel in different steps. When you select the panel in the drawing area, its 
actions appear highlighted in the tabular area in each step in which the panel plays a role.  
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Note that no step is selected, which disallows any editing of the panel actions. To begin editing a panel 
action, select the step that contains the panel action. See the following picture:  
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In Step 3, we have changed the folding angle (93 degrees) of Panel 6. 

TIP: Alternatively, you can create your own steps and actions. Delete the default ones, and create, one by 
one, the steps that you need.  

8. You can now animate the 3D model by using the animation buttons on the toolbar. To animate the 
folding sequence of the design from Initial State to Usage, click the Initial State and then click the Play 

button . To animate the design by steps and phases, click the Fold/Unfold Phase and Fold/Unfold Step 
buttons (highlighted). 
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Creating a production phase in the 3D model 

A production phase is necessary to prepare the design for closing, filling and usage. In production phase 
you define the folding sequence by indicating the number of crease lines and prefolds. 

A production phase is generated within a wizard, which offers templates for how a box should fold. The 
templates differ by the positions of the glue flaps and the number of crease lines. 

1. To create the production phase, click Generate Production Phase . 

 

2. The Production Phase Generation Wizard opens. Its left-hand pane presents the standard folding 
box types. In the right-hand pane you can see a preview of the selected folding box type. As background 
you see the design. 
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3. To switch between the preview of the selected folding box type and your design, click Show Design 

. You will see the design in color. As background, the selected folding box type appears as a grey 
contour. 
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4. In the left-hand pane, select a folding box type that matches your design. Pay attention to: 

• The top and bottom flaps. 

• The position of the glue flaps: these should match those of the design. 

• The number of the crease lines. 

5. For our example we choose Type01. After selection, the program shows in color the folding type and 
the number of creases along the X and Y axes. As background, you see your design in contour lines. 
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4. Click Next. The Production Phase Generation Wizard opens at the X Dimensioning step. At this step, 
you select the vertical creasing lines at which the folding of the box will take place.  

 

The dimension to be specified is highlighted in the left-hand pane. 

5. To define how the glue flap will be creased, click the crease line of the glue flap. 

6. Define the rest of the X dimensions by clicking each parallel line to crease/cut.  
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7. Click Next. The Y Dimensioning step appears. Define the Y dimensions in the same way as those for 
the X dimensions. 
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NOTE: The dimensions in brackets are optional (Y0, Y1, Y4 and Y5). to skip them, you can use Skip . 

8. Click Skip  to skip the (Y0) dimension since we don't need it in our design.  

9. Define the rest of the Y dimensions. Skip the optional ones (Y1, Y4 and Y5) and leave Y2, Y3 and Y6 
(pictured).  
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9. Press Next, which takes us to the Box Preview step. Here you can define whether or not you need a 
prefold. By using prefold a flap is mechanically folded and unfolded again so that better crease lines are 
formed. This is necessary for the box to open more easily when it is being filled (reset forces). 

10. To enable the prefolding, select the Prefold 1 and Prefold 2 check boxes. 
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11. Click Finish. This generates the production phase in the folding sequence. A new phase, Production, 
is added in the tabular area between the phases Initial State and Usage. In the graphical area the design 
is displayed in production phase.  
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TIP: You can use the buttons from the navigation toolbar to show animation of the folding sequence. 
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Use  and  to play the entire animation.  

Use  and  to animate a phase. 

Use  and  to animate a step.  

 

Loading an image 

NOTE: Adding artwork to structural designs is best done if you work with Adobe Illustrator, with which 
Package Designer is integrated. Adding the artwork in Adobe Illustrator is automatically visualized in 3D. 

We will load an image and place it on the box to present the final box to the customer. 

1. To load an image, click the Drawing 1 tab to display the 1up and then go to the Objects tab. 

NOTE: You can place images on either side of the design. 
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2. Click the Quick Image button . 
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3. In the Open dialog, browse to the C:\EngViewWork5\EngView Samples\Images folder. Select the file 
Aquafit.jpg, and then click OK. 

 

The image is automatically centered onto the design.  
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The marker  indicates the design’s front side and the grain direction (flute direction in corrugated 
materials). If you don’t see the marker, do one of the following: 

• Right-click in the graphical area (outside the image) and select Show > Front/Rear Side Marker. 

• On the Tools menu, click Options, and then in the View tab select the Front/Rear side marker 
check box. 

In the top left corner, you will see an indicator for the front side, respectively, the rear side. To switch 
between the sides, do one of the following:  

• Right-click the icon, and then select View front side. 

• Right-click the drawing’s tab, select Properties … and then, in the dialog box that appears, in 
View side, choose Front or Rear. 
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5. Go to the 3D drawing, where you can see the loaded image 

6. Save the file as Aquafit_design.evd in the EVD folder.  
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Export 3D models 

The program supports export to several file formats. Except PDF, jpg, tiff and bmp, we can also export 
VRML files, but only if we have the respective plug-in installed on our local machine. 

NOTE: You must be in the 3D tab to export a PDF file. 

1. Click Export . 

 

2. An Export dialog appears where you can set up the parameters for the PDF export. Define the order of 
the animation — starting and end phase. Select the View file after generation check box to open the 
PDF file automatically after saving it. 
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CAM – Cutting Packaging Box; Using Sample Counter 
 

Task 

In this exercise we will make a sample packaging that will be cut on a plotter. To do this we will 
generate a tool path. In the sample, to make the creases more explicit and the folding easier, we will 
use an underlay tool (sample counter). 

Tool path 
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Sample counter 

 

 

 

Exercise description 

 

CAM 

1. From the Library of Resizable Designs, open EVF11021.evr, and go to the 1up drawing. 
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2. On the CAM tab, click New CAM Drawing . 

The CAM-related buttons become available. 

 

 

NOTE: When you generate a CAM drawing for the first time after the program has been installed, a 
dialog appears in which we select a template for the plotter from the drop-down menu. 
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Package Designer offers plotter templates with their respective properties. After selecting a plotter 
template, the program displays the tools in the template and their respective properties. 

3. When we have used the CAM functionality before, the template that was used last is loaded. We 
can choose a CAM template – for example, Aristomat1310 – from the drop-down list. The program will 
also display, in the graphical area, what the selected machine will look like. 

 

About CAM tools 

The CAM Tools tab displays the tools that are available for processing the material. The tools are 
predefined for the selected CAM template. Each tool appears with its predefined properties – for 
example width, the style (this is the color in which the tool path of the tool will be visualized during 
animation), options for processing inner contours, the velocity at which the tool moves across the 
drawing and acceleration. 
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CAM tools 

About tool filters 

Tool filters are the rules according to which the objects in the drawing are associated with the 
respective plotter tools that will process them. The tool filters are specific for the CAM template to 
which they belong.  

 

The available tool filters are visible in the Tool Filters tab in the tabular area. 

In a tool filter (pictured) the tool associations are based on the general object attributes — among 
others, type (line, arc, and so on), style, color, pattern. 
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4. To define the cutting and creasing paths, click Generate Tool Path . 

The Generate Tool Path dialog box appears. 

When no association with a tool exists for an object – this is the case when generation of a tool path is 
done for the first time – tool filters are always applied. This creates the associations necessary for 
processing the objects.  

 

When a tool path is being generated for the first time, the Tool Filters area is unavailable for editing 
because the use of filters is mandatory. 

Using tool filters 
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You can edit the settings in Tool filters section when tools have been associated with particular 
objects. We can have two situations:  

• If we need to again create associations by using tool filters without saving the previous ones, 
select both the Use tool filters and Clear associations before generation check boxes. 

• To keep the current associations and create new ones by applying the tool filters to objects, 
select the Use tool filters check box and clear the Clear associations before generation 
check box. In this way the object will not lose their earlier association. NOTE: Objects may be 
associated to more than one tool. This is the case when the object meets a condition in a tool 
filter that associates it with an instrument other than the first one. Consider the following 
example: An object in the Cutting style is associated (manually) with the Drawing Pen. When 
the tool path is being generated automatically and tool filters are used, the object will acquire a 
second association – to the cutting tool. The reason is that the Cutting tool filter associates all 
objects in the Cutting style to the cutting tool.  

 

Merging objects 

In the section Merge Overlapped, we define how objects will be merged. Enable both options in the 
Merge Overlapped section of the Tool Path Generation Options dialog box. This will detect and 
merge overlapping objects that share the same properties to prevent the plotter from processing these 
areas multiple times. 

 

Parts (tool path generation for layout drawings) 

 

The Parts section becomes available when we need to generate a tool path for a layout drawing that 
features individual 1ups. The program processes each 1up separately. The processing sequence can 
be selected in the drop-down list: by either columns or rows. 

5. Click OK. 

The tool path is generated. The arrows in the drawing indicate the paths of the individual tools during 
the generation of the sample. During the generation of tool path, the program always generates an 
optimized path. 
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Generating NC code 

An NC code is a set of instructions that the cutting machine uses to execute the generated tool path. 

1. Click Generate NC .  

The Generate NC dialog box opens. 

The list displays the instruments set in the CAM template. 
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The NC can be put out in three ways: 

• None The NC commands are stored in a file, which is then loaded in the machine. 

• Port The NC commands are sent directly to the machine. 

• Printer The NC commands are sent to a virtual network printer (Generic/Text Only), to which 
the plotter has access. 

2. Click OK. 

 

Animating the tool path 

1. To animate how the design will be processed, click the Animate tool path  button. 

The CAM Animation Control dialog box appears. 
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 The CAM Animation Control dialog box has the Pause, Stop and Restart buttons. These let you 
follow the movement of tools.  

The sections Zone, Tool and Object, provide information about what is currently being animated.  

2. Use the slider to control the animating speed.  

3. Select the Display tool position check box to see the tool at the current processing position. 

4. To only see the drawing tools and not the folding box design, select the Hide drawing during 
animation check box. 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 



 

 

5. Click Close to exit the animation. 

 

Changing the cutting direction 

You can manually change the cutting direction to prevent damaging the material. 

1. Click Set Cutting Directions  tool to define — or edit — the cutting direction manually. 

Additional modes are available for manual editing of the cutting directions. 

 

 Set direction from tool path Use this mode to keep some of the directions when you created 
the tool path before you made manual direction changes. 

 Reverse direction Use this mode to reverse the current direction of an object on which you will 
click. 

 Delete direction Use this mode to delete the direction of the object on which you will click. 
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 Positive direction Depending on which half of the object you click, sets the cutting in the same 
direction. For example, if you click the right half of an object, the cutting direction will be to the right; if 
you click the left half, the cutting direction will be to the left.  

 Split from center Applying this mode on an object splits the tool path in the object’s middle.  

HOW TO CLICK 

• If we click near the middle, the two cutting directions will point towards the middle. 

 

• If we click any end of the object, the two cutting directions will start in the middle and will point 
toward the two ends of the object.  

 

NOTE: We can set cutting directions to more than one object at a time. To do this, select the objects, 
and then use the respective direction-setting mode. For example, we may select all objects in the 
Cutting style, or all curves. You can use the Select Object functionality, available on the context menu. 

When we have selected the objects that we need, and then click Set Cutting Directions , the 
following cutting direction modes become available: 

 

 Positive direction When you apply this mode, the cutting direction will change from left to right 
or from top to bottom. 

 Negative direction When you apply this mode, the cutting direction will change from right to left 
right or from bottom to top. 

 Split toward center When you apply this mode, two cutting directions are set, which point toward 
the center of the object.  

 Split from center When you apply this mode, two cutting directions are set, which point toward 
the two ends of the object. 

 

2. There are situations in which sharp angles need to be processed in a special way to prevent 
material damage. In our case such a critical area is the area where the dust flaps attach to the tuck-in 
flaps. The processing of sharp angles can be set also automatically – see Situation 2 later in this 
section. 

We will change the tool direction on the dust flap towards the tuck-in flap. Here the cutting direction 
needs to move toward the objects’ meeting point. This serves to prevent material damage. That is why 
we need to change the cutting directions of the two dust flaps objects.  
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We can change the cutting directions either manually or automatically. Before changing the cutting 
directions, consider the following situations: 

•  Manually 

1. To make manual changes to the path, click Set cutting direction , and then, in the 

contextual edit bar that appears, click Positive direction  . Then click the object whose 
tool path direction you want to change (see the highlighted object in the picture). 
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2. Repeat the procedure for the rest of the objects. 

NOTE: After we have started editing the tool path, the tool path we have just generated 
disappears. After we have finished with the editing, we need to generate a new tool path. 

 

We have edited the old tool path, which has ceased to exist.  
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NOTE: While applying path direction, you can use the Repeat changes functionality . This 
will apply an action to all the positions in the tool path where there are identical path patterns. 
This is especially useful when we are editing a tool path for a layout drawing that contains 
identical designs. 

•  Automatically  

Automatic setting cutting direction for processing of sharp angles.  

1. On the CAM toolbar, click Detect Directions . 

The Detect Directions dialog box appears, in which the rules are set for the sharp angle 
processing. 

 

Objects angle Sets the maximal angle at which two objects may meet. If the angle value is less 
that the set value, a special tool path will be generated for them (the cutting directions will move 
toward the edge they form).  

Minimum size Sets the minimal length of the objects for which the tool path processing rule will 
be applied. 

 

Instruments for design positioning  

The following tools on the CAM toolbar control the positioning of the design on the machine. 

 = Position alignment 

Positions the drawing manually by dragging the mouse or by setting Dx and Dy offset values. 

 = Orientation alignment 

Rotates the drawing manually by dragging the mouse or by setting a Rot Value angle. The rotation 
angle is set between the following two axes: the one defined by the point of clicking and the origin of 
the plotter’s coordinate system and the one defined by the point where we want to relocate the point 
and the origin of the coordinate system. 

 = Design alignment 

Opens the dialog where you can align (move and/or rotate) the drawing via coordinates. 
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 = Sheet  

For improved representation of reality, you can use a sheet whose dimensions are identical with those 
of the actual one. 

3. To generate a tool path that will take into account the changes, on the CAM toolbar, click Generate 

Tool Path . 
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 = Show drawing 

Shows the structural design. 
 = Show tool path 

Shows the tool path. 

 

Generating sample counter 

We will create a sample counter to make the creases in the sample more pronounced and to make the 
folding of the sample easier. A sample counter is a plate with cut channels indicating the creasing 
objects. The sample counter is placed onto the machine and remains on the plotter. The material from 
which the sample will be cut is placed onto the sample counter. Additionally, the sample counter is 
fitted with vacuum holes that allow the holding of the material on the sample counter. After the material 
is aligned onto the sample counter, the cutting begins. 

1. On the CAM toolbar, click New Sample Counter Drawing . 
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The Sample Counter Generation Options dialog box appears. 

 

NOTE: In the Generation Options area we set the width of the channel (the distance between two 
lateral lines of the channel). In Correction, we set the offset between the end of the folding line and 
the end of the channel line.  
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Without correction. The end of the folding lines coincides with that of the channel line. 
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With correction. The end of the folding lines is stops at a distance from that of the channel line, 
entered in Correction. 

2. If you have cut-crease objects and want to have them transformed into individual cutting and 
noncutting sections in the sample counter, select the Decompose cut/crease objects check box. 
This results in little holes for the creasing sections (pictured). If the cut-crease objects are not 
decomposed, a single channel for the entire object would be cut as if the entire line were in the 
Creasing style. 
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An object, originally in the Cut-Crease style, after processing. Notice the noncutting sections, which 
are separated from those that are to be cut. 

To increase the air-sucking effect on the sample counter, vacuum holes must be generated. 

3. In Generate Vacuum Holes area, in Offset you specify the distance of the vacuum holes to the next 
object – a fold/crease or vacuum line. Type the minimum size of the vacuum hole in the Min box. 

4. Consider the following situations:  

• If we want to create manual editing of the sample counter job, which will be created in 
accordance with the rules we have set, we need to leave the Create CAM drawing check box 
empty. This creates a sample counter drawing in which we can make the necessary 
corrections. When we are ready we continue by creating a new CAM drawing. 

• If we want to create a CAM drawing directly for the sample counter drawing, we select the 
Create CAM drawing check box. The result is that we have no stand-alone counterplate 

drawing but a CAM drawing (it is indicated by the  icon). 

NOTE: No manual editing is possible in this CAM drawing. If we need to make corrections, we 

click Generate Sample Counter Drawing . Notice that in the dialog box that appears, the 
Create CAM drawing check box is missing because all editing now takes place in the CAM 
drawing we have just created. In the dialog box, make the changes that you want, and then 
click Apply to see the result before clicking OK. This re-creates the CAM drawing. 

5. To confirm the settings, click OK. 
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NOTE: The sample counter tool path drawing appears, displaying the result. The sample counter is 
positioned in the same place as the design in the main tool path. This is why after we have generated 
the sample counter drawing, we are advised not to change the box’s position in the main CAM tool 
path. However, if, due to technological reasons this must be done, we refresh the sample counter 
drawing (if we have created one) and then the CAM drawing. Note that refreshing the sample counter 
drawing removes all manual changes we have made.  

Splitting designs 

If you must work with materials that are larger than the machine's work area, you can split them into 
parts, which you process separately. This is useful for both manual feed and a machine with a roller. 
The entire procedure includes the use of splitters and align markers. 

1. Open the design EVC51002. 
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2. Create a CAM drawing: On the CAM toolbar, click New CAM Drawing . Then load the Zund 800 
CAM template. 
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The design proves too large for the machine’s work area. That’s why we need to split it and process 
each of its part separately. 

3. On the CAM toolbar, click Insert Splitters . 

The Insert Splitters dialog box appears. 
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In this case it is sufficient to split the design into two parts. After we click OK, a splitting line appears 
that divides the drawing in two. It shows which objects fall in which part. 

 

If we will cut the design manually, we shall need aligning markers. 
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Left-hand marker Right-hand marker 

The program positions the aligning (splitting) markers over the splitting line left by the processing tool. 

The align markers will be processed by the tool that has been associated with them. To associate a 
tool to process the align markers, double-click the tool in the CAM Tools tab, and then select the 
Associate with align markers check box (pictured). 

 

TIP: To change the splitting of the design, click Remove Splitters . Then relocate the design and 
apply a new splitting. 

4. To switch between the two section, click Next Zone . 

5. Generate tool path: click Generate Tool Path . 
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The tool path takes the splitting into account and the two sections of the split design are processed 
one by one. 
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Creating and correcting a layout 
 

Task 

In this exercise you will learn how to make a sheet layout from a 1up with the help of a wizard. The sheet 
layout is then to be exported as a CFF2 file. 

The complete layout 



Exercise description 

In the first step we are going to create a layout from the 1up with the wizard. 

Creating layout 

1. On the File menu, click New. In the wizard that appears, click From Resizable Design.  

2. Browse to C:\EngViewWork5, and click Toggle Flat Mode .  

3. Type EVF11021, and select the file. Then click Finish. 

The design opens. 

 

4. Go to the Layout tab to start creating a layout. 

5. Do any of the following: 

 On the Layout menu, click New Layout Drawing. 

 On the Layout tab, click tool New Layout Drawing . 



 

The Select Layout dialog box appears. 

 

6. Click Run layout wizard, and then click OK. 

7. To customize the layout, select the option User template from the pop-up menu Predefined template in 
the Select Template window. 

NOTE: The layout wizard forms an array of four layout 1ups, which is then multiplied across the sheet. 
For more standard cases, the layout wizard offers predefined templates — 1x1; 2 rows, 2 columns, 2 
parts in rows; 2 parts in columns.  

NOTE: The buttons in the Rotation area let you rotate the layout 1up. 



 

8. To go to the Second Part window, click Next. 

The second part appears aligned with the first. 



 

9. Click Next to go to the Third Part window. In this step you define the offset and the position of the next 
layout row. 



 

10. Rotate the third part at 180 degrees (highlighted). 



 

11. To align the third part horizontally to the first part, in the Horizontal Alignment area, click the Align 
Horizontal Center button (pictured). Then click the lines that will control the alignment: Line 1 and Line 2 
(pictured). Upon clicking Line 2 the alignment is carried out. 



 

Note that in Correction, the distance of the alignment (–47.50) is displayed automatically. 



 

12. Now we’ll align the third part vertically up to the first part. In the Vertical Adjustment area, click the 

Move Down  button.  

The third part attaches automatically to the first. In Correction, the value of the alignment (–71.00) is 
displayed automatically. 



 

13. In Gap, enter a 5 mm for the gap between the first and the third parts. 



 

14. Click Next. 

The Fourth Part step appears. 

In this window you can check how the rows and columns are arranged in relation to each other. You also 
can correct the position and the alignment. 



 

15. Click Next to go to the Sheet Placement step.  

 

Sheet definition 

In the second step we will define the sheet. There are three methods for this: (1) by fitting 1ups to a 
predefined sheet; (2) by choosing an optimal sheet; (3) by calculating the sheet size according the 
number of 1ups. 

METHOD 1: Fitting 1ups to a predefined sheet size 

A layout you create will be based on a custom sheet format User Defined. In the table you can check the 
width, the height and the margins of the sheet and of the layout. The last column indicates a value that 
you must add to the sheet format if you want to place another column or row. 

You can enter your own values for the sheet  



 

or click the Sheet column in the table to select the sheet format (pictured). 

 

When you select a different sheet format, the number of columns and rows will be recalculated 
automatically and the 1ups will be positioned according to the selection. 



 

NOTE: To see an alternative layout array, rotated at 90 degrees counterclockwise, you can use the 
functionalities for displaying statistical information and then choose whether or not to use rotated layout. 
Select the Statistics check box. This changes the data in the table, displaying the alternatives in bold 
case (pictured). 



Straight layout settings   Settings for layout rotated at 90 degree. 

 

METHOD 2: Defining sheet size by choosing an optimal sheet 

1. Click the Opt. Sheet button below the table to run the wizard. This starts a method of sheet selection 
that offers the sheet with least waste. 



 

 

2. In Optimal Sheet Selection: Input, specify the total number in the Number of pieces box.  

Available sheets lists the sheets that you have. 

TIP: To edit the list, on the Format menu, click Sheets, and then remove unnecessary sheet formats or 
add new ones. 

3. Select the respective sheets in the Available sheets list box and click the  button to add them to 
the list of selected sheets. The selected sheets appear in the right list box. 



 



 

NOTE: To select all available sheets, press the button . This sets ups all the sheets as possible 
choices for the final sheet. 

 

Allow rotation of the layout — the layout 1ups can be rotated to include optimization options.  

Trim sheet's width by layout —  trims the sheet according to the width of the used layout. 

Trim sheet's height by layout — trims the sheet according to the height of the used layout. 

 

4. Click Next to go to the Select Best Sheet window. 

In this page the sheets are listed in descending order according to the percentage of waste area. 



 

The list box provides information on the number of required sheets, the number of 1ups per sheet, the 
total number of pieces produced and the amount of waste for each selected sheet format. 

5. Choose Bobst SP 142 list box, since this selection would result in the least waste; then click Finish. 

In the selected sheet size, the program has fitted as many 1ups as possible. 

 

METHOD 3: Calculating sheet size according the number of 1ups per sheet 

In this method you enter the number of 1ups per sheet that you need. Then you  use the Calc Sheet 
button. The program computes the sheet size. During the computation, also the margins get taken into 
account.  



 

After you have chosen one of the three sheet size definition methods and have your final sheet size, click 
Finish to complete the procedure. 

The finished layout appears in the drawing area. 



 

 

Recalculating a template 

You may need to make corrections to the 1up to be able to fit more boxes into the layout. A standard 
correction is the editing of the glue flap width. In this case, we will edit the width from 12 to 10 mm. This 
affects the rule-to-rule width of the box (the overall horizontal dimension). 

1. In the 1up drawing, change the expression of the GL parameter, which controls the width of the glue 
flap, to 10. 



 

As a consequence of the editing a gap appears in the layout (pictured). 



 

2. In the layout drawing, on the Layout toolbar, click Recalculate Template . 

The program updates the array with the new size of the box. The gaps are eliminated. 



 

 

Applying layout to a new sheet 

When you have a template-generated layout, you can later apply a new sheet to the already-defined 

array of the boxes. To do so, on the Layout toolbar, click Apply Layout Template to New Sheet , 
and then, in the dialog that appears, proceed with the definition of the sheet. 



 

The application of the new template can be carried out by using any of the three sheet definition methods 
described above. 

Exporting layout in the CFF2 file format 

The layout drawing can be exported as an CFF2 file.  

1. Make sure the Layout window is shown. 

2. Choose File > Export. 



 

The Save Project dialog box appears. 

 

3. Choose the option Common File Format CFF2 in the pop-up menu File of type and save the file to the 
proposed folder. 



 



 
 

Generating varnish blanket 

Task 

In this exercise, you will learn how to generate a varnish blanket. You can then choose to generate a 
layout to the design. 
 

1up 

 

 
 

Complete layout 
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Varnish blanket 
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Exercise description 
 
Creating a varnish area automatically 
 
We shall now create a varnish area from the drawing. The varnish area will indicate the places which will 
be coated with varnishing substance. 

1. Open EVF11001.evr and on the Layout tab, click New Varnish 1up Drawing . 
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A new drawing appears, in which we will set the areas that will be varnished. 

2. Select the areas on which varnish will be applied.  
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The highlighted lines mark the area that will receive varnish coating. 

3. To create the bleed, on the Transformations menu, click Offset . 

The Offset dialog box appears.  
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4. Select the Hull option. This guarantees that the offset will encompass all the marked areas in on 
integrated area. 

In Properties, select Outer to ensure that the offset will be applied outside the marked area. 

In By, enter 3 mm. 

In Style, select Bleed. 

In Round with, select Line, and enter 89 degrees for Angle threshold. 

NOTE: If the Bleed style is not available in droh 

 

pdown list, it must be added manually. 

5. Click OK. 

The offset is applied. 
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Now we shall indicate the area that will contain the glue. This area need not be covered by the bleed. 
 

6. On the Objects toolbar, click Rectangle , and ensure that the drawing will be done in the Gluing 
style. 
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7. Draw a rectangular area in the glue flap. 
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Creating a varnish area manually 
 
You can use a manual drawing mode with which you can point to the objects for which you want to create 
a bleed zone. The setting of bleed is especially easy, as you only need to point to the objects and the 
bleed is added automatically after a click. 

1. Create a varnish drawing — see Step 1 in the previous exercise. 

NOTE: You can make more than one varnish 1up drawing. 

2. On the Objects toolbar, click Quick Offset . 

A contextual edit bar appears above the graphical area. 

 
3. On the edit bar, click Continuous . This starts the continuous offset-drawing mode, which 
guarantees that each offset line will follow from the previous one and there will be no gaps. 
 
4. Click the object from which you want to start drawing the offset contour. 
 
5. Move the mouse pointer over the object and you will see the available offset options — these appear  
on either side of the object. Choose the one that you need. 
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The offset is placed along the side you chose. 
 

 
 

The first action in the manual setting of bleed 

 
 
6. Click the next object that will form the offset contour. The program connects the offset with the already 
set offset of the previous object. 
 

 
 

The continuous drawing of bleed has been activated.  It allows the application of bleed in a continuous 
way. 
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7. Repeat Step 7 until you have created offsets of all the objects but the last one. 
 

 
 
8. To complete the offset contour, click Select Object To Close Offset With .  
 
9. Click the last object to which offset is to be applied. The program connects the offset for the last object 
with the offset for the first object and closes the offset contour. 
 

 
 

The final bleed object has been applied. 
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Generating varnish blanket 
 

1. In the layout drawing, on the Layout toolbar, click  Generate Varnish Area Drawing . 

 
 
2. In the Varnish 1up column, select the varnish 1up drawing that you want to use, and then click OK. 
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The varnish area is generated. 
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3. To generate the varnish blanket, on the Layout toolbar, click Generate Varnish Blanket . 
 
The Blanket dialog box appears. 
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4. Accept the defaults, and click OK. 
 
The varnish blanket is generated. 
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Creating Cutting Die 
 
Task 

In this exercise, we will open a design and then place the components necessary for the creation of a 
cutting die: stripping knives, dieboard, chase holes and compensating rules. 

NOTE: This is the first part of a two-part exercise project for creating a die. After the bridges drawing 
has been created, in the second part of the exercise we will create stripping tools: a male and female 
dies, and a front stripper. 

 
1up 
 

 
 
 
Layout 
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Cutting die 

 
 
 
Exercise description 
 
We start by opening the Diemaking Exercise.evd file, in which we have a predefined layout. To access 
the file, go to C:\EngViewWork5\EngView Samples. 
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The layout that we will use 
 
The material used in this project is folding carton. The project will be die-cut from the front side. 
(Normally this is the printed side.) This makes it necessary for the die project to be mirrored. That is 
why in the layout drawing we will switch the point of view. (This is done to make working on the project 
as natural as possible — that is, we will be looking at the die’s front side.) To do this, on the icon in the 
upper left corner, right-click, and then make sure that View front side is unchecked (pictured). NOTE: If 
the icon is not visible, on the Tools menu, click Options, and then, in the View tab, select the 
Front/Rear side marker check box. 
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The rear side of the layout  
 
Placing stripping knives 
 
After a layout has been created, we must place stripping knives. We shall place horizontal and vertical 
stripping knives (these are positioned between the upper row of 1ups and the upper border). 
 

1. On the Layout toolbar, click Stripping Knife . 
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A contextual edit bar appears above the graphical area which contains the functions of the stripping 
knife placement. 
 

2. To place horizontal stripping knives, in the contextual edit bar click the Horizontal Strip Knife .  
 
3. Position the mouse pointer against the lowest row of 1ups. 
 
NOTE: This positioning of the first pair of stripping knives will mark the front stripper. Because of the 
front stripper's special role in the die, the stripping knives that mark it are positioned differently. That’s 

why, make sure the Repeat Changes button —  — is not pressed in. This will prevent the 
placement of the stripping knives further up the sheet.  
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4. Placing the rest of the horizontal stripping knives. Now the rest of the horizontal stripping knives will 
be placed. To ensure uniformity of positioning alongside the layout’s vertical side, ensure that the 

Repeat Changes button —  — is pressed in. 
 
NOTE: Notice that the Repeat Changes functionality placed stripping knives also to the lowest row of 
1ups, to which we had added stripping knives earlier. To remove the doubling of the stripping knives 
there, turn off the Repeat Changes functionality, and delete the unnecessary knives.  
 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

7 



 
 

 
 
5. Now we will place the vertical stripping knives in the upper section of the layout. On the contextual 

edit bar click Vertical stripping knife , and start placing vertical stripping knives one by one 
(pictured). 
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Editing the stripping knives 
 
We will show how the stripping knives, can be edited — that is, they can be moved or deleted. 
 
1. To delete the leftmost vertical stripping knife, right-click it, and then click Delete. 
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2. Place an angular stripping knife to the left of the deleted knife (pictured), click Vertical stripping 

knife . 
 
3. Now we will place stripping knives at selected angles inside the layout. On the contextual edit bar, 

click the Bottom Left  stripping knife . 
 
NOTE: To ensure identical shape and position of the stripping knives across the identical 1ups, ensure 

that the Repeat Changes button —  — is pressed in. Additionally, you can set fixed offsets for the 
stripping knives, which will ensure precision of the knife’s size. In the contextual edit bar enter 
corresponding values in the X Offs and Y Offs fields, and then use the relative point functionality 
(pictured). For details about how to use the functionality, consult the help system at Drafting | 
Working With Geometric Objects | Drawing Geometric Objects | Setting relative point.  
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Positioning angular stripping knives. 
 

4. On the contextual edit bar, click Bottom Right stripping knife  , and place stripping knives 
symmetrically to the ones placed in step 3. 
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5. Place vertical stripping knives in the spaces between the 1ups, click Vertical stripping knife . 
 
 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

13 



 
 

 
 
All necessary stripping knives are now placed. 
 
Selecting Dieboard 
 
The next step in the die design is the selection of a dieboard.  
 

1. On the Layout toolbar, click Dieboard . 
 
The Dieboard dialog box appears. 
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2. In Name, select the dieboard that you need, and then click OK. 
 
The dieboard appears in the graphical area and is marked in the Dieboard style. 
 
By default eight chase holes appear. 
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Setting chase holes 
 
We can set our own chase holes, depending on our project’s needs.  
 

1. Click Chase Holes . 
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A contextual edit bar appears above the graphical area, and a grid of the potential chase holes. Notice 
the difference in the appearance of the active chase holes (double circles) and the potential chase 
holes (single circles). 
 
2. Consider your situation: 
 

• To use the automatic setting of chase holes, on the contextual edit bar, click Arrange Chase 

Holes . 
 
The Arrange Chase Holes dialog box appears. 

 

 
 

Edit the settings as you need them to be, and then click OK. 
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• To set the chase holes manually, in the grid of chase holes, click a potential chase hole 
(pictured). It changes its appearance to a double circle. Use this to set as many chase holes 
as you need. 

 

 
 
 
Placing compensating rules 
 
Next we will place compensating rules. Тhe program calculates the number of compensating rules 
automatically. 
 

1. On the Layout toolbar, click Compensating Rules . 
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The Compensating Rules dialog box appears. 
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The program computes the number and the positioning of the compensating rules. If we need different 
positioning of the rules, we can edit the settings accordingly. 
 
2. To adopt the settings, click OK. 
 
The compensating rules are placed atop the dieboard and are highlighted in yellow. 
 

 
 
Positioning of the compensating rules 
 
Locking the dieboard and locking the sheet 
 
Locking the dieboard and the sheet ensures that the die will stay static during any changes made to 
the layout or the die. 
 
1. Position the mouse pointer over the outer line of the dieboard, and then right-click. Then on the 
context menu that appears, click Lock. 
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2. Repeat the procedure on the sheet. 
 
Both the sheet and the dieboard are now locked. This is indicated in the center of the lower part of the 
dieboard. 
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The sheet and the dieboard are locked. 
 
Adding additional components: holder hole 
 
Additional components may be added to the dieboard that include tables, labels, handle holes and so 
on. 
 

1. On the Layout toolbar, click Quick Features . 
 
A contextual edit bar appears above the graphical area, containing the controls of the features. 
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2. In Components, click the down arrow, select Holder Hole, and position it on either side of the 
dieboard.  
 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

23 



 
 

 
 
Adding text to the dieboard 
 
We will add a text to identify the dieboard. 
 

1. On the Objects toolbar, click Vector Text , and then select a font. 
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2. In the contextual edit bar that appears, enter the text that you need, and then drag it to the place in 
the dieboard where you want it. 
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Creating cutting die bridge drawing 

1. On the Diemaking tab, click New Bridges Drawing . 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

27 



 
 

 
 
A dialog box appears, prompting you to select the side from which the bridges drawing will be 
generated. 
 

 
 
2. Click Die side, and then click OK. 
 
A dialog box appears. 
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3. Click Yes. 
 
The bridge drawing is created in which we should choose a bridge template to apply. 
 
4. On the Diemaking toolbar, click Place Bridges. 
 

 
 
The Place Bridges dialog box appears. 
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5. In Bridge template, choose the template that you want. 
 

 
The dieboard drawing with a bridge template applied.
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6. Save the file. 
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Creating Stripping Tools 
 
Task 
 
This exercise takes up from the result of Exercise “(08) Creating Cutting Die”. We will create the 
stripping tools for the cutting die we created earlier: male and female dies, front stripper. These are 
used to dislodge the waste from the cut sheet. While creating these tools we will place the following 
components: strip pins, male lifters, mounting bars, vacuum holes, transportation bolts. We will 
complete the project by creating bridge drawings. 
 
As an optional functionality we will show how several bridge drawing can be combined for batch 
cutting. 
 
See the bridge drawings projects for the three stripping tools: 
 
Male stripping die 
 

 
Female stripping die 
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Front stripper 

 
Exercise description 
 
Setting contours 
 
We start by setting the contours that will mark the useful area from the waste. 
 
1. Go back to the layout drawing. 
 

2. On the Diemaking toolbar, click Create Die Contours . 
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The Stripping Contour Options dialog box appears. 
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2. Accept the defaults and click OK. 
 
The first contour is created automatically, applied to the lower front stripper. 
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3. Now we shall proceed with the creation of contours for the rest of the 1ups. To make the contour 

creation easy and uniform, ensure that the Repeat Changes button —  — is pressed in. 
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4. Now click any of the 1ups. The contours are created automatically in all identical 1ups.  
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The contours are set. 
 
Generation of the stripping dies 
 
Now we shall create the male and female stripping dies, as well as the front stripper. These will be 
visualized in separate drawings. 
 

1. On the Diemaking toolbar, click the Generate Stripping Dies button . 
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The Stripping Dies Generation Options dialog box appears. 
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2. In the Male & Female Stripping Die Options area, click More. 
 
The More Male & Female Generation Options dialog box appears. 
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3. Click OK. 
 
Three new drawings are added to the project – for the male and the female stripping dies, and for the 
front stripper. 
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4. To get a clearer view of the stripping die, hide the parent drawing: in the graphical area, right-click, 
and then click Show Parent Drawing. 
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The front stripper 
 

 
 
The male stripping die with the parent drawing hidden 
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The female stripping die with the parent drawing hidden 
 
In the male stripping die, some of the stripping wooden pieces have been substituted by stripping 
knives, which we will now edit out. This must be done to ensure better stripping of the waste. This 
editing will result in more effective strippers. 
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To be able to draw, we show the parent drawing. It is necessary to take the parent drawing into 
account. That's why we visualize the parent drawing. 
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Visualization of the parent drawing 
 

 
 

135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

16 



 
 

 
 
Placing strip pins 
 

1. On the Diemaking toolbar, click Stripping Die Components . 
 
A contextual edit bar appears above the graphical area. 
 
2. In the contextual edit bar, in Components, click the down arrow, and click Strip Pin 1. 
 
NOTE: To ensure identical positioning across the dieboard, ensure that the Repeat Changes button 

—  — is pressed in. 
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Here the component is placed and an additional stripping line is drawn. 
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A strip pin is inserted. 
 

 
 
3. Continue with the editing of the rest of the zones with stripping elements. 
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In the positioning of the stripping lines, the parent drawing must be taken into account. 
 

 
 
The result. The lines of the P13 element have been erased, because the element is replaced with 
stripping knives. 
 

 
 
4. Continue with the editing of the next zone. 
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Final view of the stripping instruments on the male stripping die. 
 
Placing male lifters 
 
Next comes the placement of lifters on the male stripping die. 
 

1. On the Diemaking toolbar, click Stripping Die Components . 
 
A contextual edit bar appears above the graphical area. 
 
2. In the contextual edit bar, in Components, click the down arrow, and click Male Lifter 03. 
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Placing of lifters into the lower left part (P1). 
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The lifters in P1: the final state 
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Placing mounting bars onto the male stripping die 
 

1. On the Diemaking toolbar, click Stripping Die Components . 
 
A contextual edit bar appears above the graphical area. In them you can set your own hole offsets for 
positioning the bar. 
 
2. In the contextual edit bar, in Components, click the down arrow, and click Male Bar. 
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Two mounting bars have been placed. 
 
Placing vacuum holes 
 

1. On the Diemaking toolbar, click Stripping Die Components . 
 
NOTE: The use of preset components is optional. These vacuum holes can be drawn by hand and 
given a particular style. 
 
2. In the contextual edit bar, in Components, click the down arrow, and then click Vacuum Hole – 
rectangle with fillets. 
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Here the vacuum holes are being positioned. In case it’s necessary, the holes can be extended or 
constricted. This is done in the contextual edit bar. 
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The vacuum holes have been added. 
 
Placing mounting bars onto the female stripping die 
 

1. On the Diemaking toolbar, click Stripping Die Components . 
 
NOTE: A contextual edit bar appears containing parameters for the bar component. In them you can 
set your own hole offsets for positioning the bar. 
 
2. In the contextual edit bar, in Components, click the down arrow, and click Plywood Bar Holes 02. 
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2. Position the two mounting bars where you want them to be. 
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Two bars have been placed. Note the two horizontal lines. They mark the place and the size of the 
locking tooth, which serves for the mounting of the die onto the machine. 
 
Placing transportation bolts 
 
We are now back to the male stripping die, in which we must visualize the female stripping die. This is 
necessary so that the bars in the female die become visible. The transportation bolts must not be 
positioned where there are bars. 
 
1. To visualize the female stripping die, in the graphical area, click and then on the context menu click 
Show complementary drawing. 
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Both the male and the female stripping dies are visible. 
 

2.  On the Diemaking toolbar, click Place Strip Clip Components . 
 
NOTE: A contextual edit bar appears containing parameters for the bar component. In them you can 
set your own hole offsets for positioning the bar. 
 
3. In the contextual edit bar, in Components, click Transportation Bolt Hole 2. 
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A positioned bolt hole. The dotted lines mark the physical size of the bolt's bed as it will be mounted 
on the stripping die. 
 
If the space is limited, the positioning of the transportation bolts can make necessary the editing of 
some components that have been already positioned. In the current case we will edit the size of a 
vacuum hole to make room for the bolt's aperture. 
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The holes for transportation bolts are positioned. For easier visual comprehension, the female 
stripping die (the complementary drawing) is here not shown. 
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Designing additional stripping elements 
 
Next we come to cutting the additional elements needed for the stripping process. This includes the 
cutting (twice) of the female bars and the lower front strippers. 
 

1. On the Diemaking toolbar, click Generate Support Tools . 
 
The Stripping Support Tools dialog box appears. 
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This dialog box contains the rules for the creation of the support instruments. The rules that appear 
are the default ones, but you can create your own.  
 
2. Create your rules, and then click OK. 
 
A new drawing appears after the rules have been created and accepted. 
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The lower front stripper and the female plywood bars for the mounting of the female stripping die 
 
Creating bridge drawings 
 

1. On the Diemaking toolbar, click Generate All Bridges . 
 
The Create Bridges for Stripping Drawings dialog box appears. 
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This dialog box lists the bridge templates that will be applied in the stripping dies. Rules for the transfer 
of objects between the male and the female dies are applied separately. An example is the 
transportation bolt hole, which is positioned into the male stripping die during the design. A 
corresponding hole is necessary for it also in the female die. 
 

 
 
2. After the association of a bridge template for each drawing, individual bridge drawings are created 
that show how each bridge template is applied. These are the actual projects for cutting the stripping 
instruments. 
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The male stripping die 
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The female stripping die with wooden chunks (on the periphery) that will be mounted on the male 
stripping die. 
 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

41 



 

 
 
The front stripper 
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Bridge drawing of the support instruments  
 
Adding bridge drawings to the pool 
 
The pooling functionality manages the combination of individual dieboard jobs that are cut at once. 
This combining is done in a layout drawing on which all wooden tool projects (cutting dies and 
stripping dies) are distributed across a single master board. The laying out of the cutting boards can 
be automatic or manual. 
 

1. On the Diemaking toolbar, click Add to pool . 
 
If your project contains unsaved changes, a dialog box will appear, prompting you to save the project 
before continuing. 
 

 
 
2. Click Yes. 
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The Add Drawings to Cutting Pools dialog box appears. 
 

 
 
The program lists all bridge drawings. Now we will choose which drawings to add to which pool. 
 
3. Select the drawings that you want added to the pools.  
 
4. In the Pool column, use the drop-down lists to select a pool for the respective drawing. 
 
5. On the Layout menu, click New Pool-Layout Project.  
 
The Pool Layout Project dialog box opens. 
 
The 15mm_Bridge drawing is added to the Die15 pool. The rest of the bridge drawings are added in 
the Die18 pool. To be cut, they must be inserted into the master layout board.  
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6. In Source pool, select the Die18 pool. 
 

 
135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria  
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14 
info@engview.com   www.engview.com 

45 



 

 
 
The highlighted rows contain the newly added drawings. 
 
7. Insert the drawings into the master layout board. 
 
NOTE: If you want these particular drawings to be cut, insert them manually. Otherwise, you can use 
the Auto Fill functionality, which will offer optimal inserting based on the current nesting method. 
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NOTE: Before cutting the master layout board, it must be saved as an EVD file. 
 
4. Click OK. 
 
NOTE: The EVD file can then be opened and a CAM job can be sent to the laser cutter. 
 
A Save Project dialog box appears. 
 

 
 
5. Save the master layout as an EVD file. 
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Editing Design Structure With Adobe Illustrator 
Task 

This exercise explores how Package Designer design is opened in AI and how its parameters are 
edited to change the design’s structure. When in AI you open an EngView design, the integration 
starts automatically. You can then see the Package Designer icon in the system tray.  

In this exercise we will open a resizable design and load the EngView workspace. Then will change 
some of the design’s parameters with the aim of changing its structure. 

Exercise description 

Opening an EngView file in AI and preparation for work 

1. In AI, browse the EngView Library of Resizable Designs and open the file EVF11908 Tapered Top 
Lock – Snap Lock. 

2. After the file has been opened, on the Menu bar load the EngView environment by clicking EngView 
(pictured). It contains the panels whose combined functionalities define the integration. 

 

COMMENT: The EngView environment is a set of predefined panels that cover the integration-related 
functionalities. It includes the EngView-specific panels (EngView Design Parameters, EngView 
Processes and EngView 3D) and the AI panels Artboards, Layers and Swatches. The EngView 
environment can be loaded prior opening of any files. 
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You can see the design’s parameters listed in groups in the EngView Design Parameters panel. 

Next we will make visible the dimension lines. We need them to see which parameter is linked to 
which dimension. This is necessary when we are editing the design’s size. 

3. To make visible the dimension lines in the design, in the Layers panel click the eye icon on the 
[Dimension Lines] row. 

 

4. (Optional) To expand the workspace, hide the panels Artboards, Layers and Swatches. We will not 
need them for the rest of the exercise. 

Editing the Design Parameters 

1. On the EngView Parameters panel, change the values of the parameters A, B and H to, 
respectively, 145, 157 and 115. Next, change also the value of the parameter HL to 80.  
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2. To update the box size with the new parameter values, click Recalculation Design . 
(Highlighted in the previous step.)  

NOTE:  As part of the editing the structure of a design, you can change also the material thickness. To 

do this, on the EngView 3D panel, click Drawing Properties , and then, in the dialog box that 
appears, type the thickness value that you need in Thickness. 
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Editing the design structure in Package Designer 

A major feature of the Package Designer/AI integration is that you can switch between the two 
programs to perform tasks specific for either program. All editing done in one program is automatically 
reflected in the other.  

We will proceed with making structural changes in the design. 

1. In AI, on the EngView 3D panel, click the menu icon, and then click Edit in Package Designer. 

 

A message appears, informing us that Package Designer is being loaded. 

2. In Package Designer, make the structural changes as shown in the video “AI Integration (01) Editing 
Design Structure”: add a 20 mm fillets to the central opening and trim the unnecessary objects. 

3. In Package Designer, to update the 3D representation, in the 3D drawing click Refresh . 

COMMENT: In the video, you see an external object inserted into the design. When we are back in AI 
we will see this object there too. 

When we have finished the editing of the design structure, two options are possible: 

• We can save the edited design as an EVD file by using the Save As command. This EVD file 
can be used for other production processes such as cutting a sample, creating a layout, 
diemaking and so on. After creating the new EVD file, we return to AI and continue with the 
work at hand. 

• We can go back to AI and proceed with the work on the graphic design. But at any time during 
our work in AI we can also export the design to an EngView Structural Drawing. This will 
create the necessary EVD file, which can be used further to continue with the production 
process. 

Returning to AI 

To proceed with the work to the graphic design, we will return to AI. 

4.  To return to AI, close the file. DO NOT CLOSE PACKAGE DESIGNER. 
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Applying Surface Effects 
 

Task 

In this exercise we will add finishing effects to certain areas on a design. In Package Designer, the 
following finishing effects can be applied to a design:  

• Backing A process in which two sheets of paper — backing paper and printing paper — are 
glued together to ensure that the packaging is solid enough and that the printing is of the 
required quality. The resultant material combines the properties of its components. Backing is 
used when packaging is produced that will hold heavier goods. 

• Color print Printing of text or image in colors other than black and white. 

• Varnishing The application of film-forming substances onto surfaces for the purposes of 
protection of the surface or for aesthetic effects. 

• Partial foil stamping The application of colored or metallic substances onto a solid surface 
(paper) as part of the printing process. The pattern of the applied substances is printed on the 
paper. 

• Lamination The addition to paper of coating substances that give it extra physical strength 
and smooth surface. 

• Special ink print  

• Imprint effects (embossing and debossing) The creation on a surface of raised (embossed) or 
recessed (debossed) relief effects. 

Where and how to apply effects 

Finishing effects are applied onto objects by means of process layers, which define the appearance of 
the surface processes. The effects can be applied onto: 

• The entire area of a drawing (backing and laminating). 

• An individual layer (the surface effects is applied to all the objects in the layer). 

• A specified spot color (the surface effect will be applied to the objects in this spot color 
regardless of the layer to which they belong). 

Exercise description 

We will create the finishing effects Imprint and Foil Stamping to some areas on the design’s surface. 

Creating finishing effects (processes) by spot color 

1. Open the file Finishing Effects Exercise.ai. The file can be accessed from 
C:\EngViewWork5\EngView Samples. 
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In this project we see an already created graphic design, which has two artwork layers: Elephants and 
Layer 1.  

We start by creating finishing effects onto the two Elephants inscriptions (in Layer 1). Since Layer 1 
contains also other object, we will mark the two inscriptions by applying a spot color to them. 

2. In the image, select the two inscriptions “Elephants” and apply a spot color to them.  

NOTE: You can use predefined spot colors (in the Swatches panel) or create your own as we can see 
in the video — Pantone 121C. 

3. On the EngView Processes panel, click New Process . 

 

A new record — None Selected — appears in the table of processes. In this record we will specify the 
process. 

4. Click the None Selected box, and from the list that appears select your spot color from the Spot 
Color group.  

5. In the Ignore box of the Process column, click, and then, from the list that appears, choose 
Imprint. This is process that we will apply to chosen spot color.  

6. In the Type column, select Emboss. 
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The effect is immediately visible in the EngView 3D panel. 

NOTE: The effect will not be immediately visible if in the EngView 3D panel Enable Auto Refresh 

check box is empty, in which case we need to click the Refresh button . Bear in mind that the 
automatic refresh may slow down your work, especially when the job at hand involves a greater 
number of graphics. If that is the case, it is better to turn off this functionality and update the 3D 
visualization manually by clicking the refresh button. 

COMMENT: The two inscriptions are now embossed but are not in color. This is the case because 
when a finishing effect has been applied to an object, the color print process — it is applied by default 
— no longer applies to it. To make the two Elephant inscriptions in color again, we need to create a 
new color print process for them. 

7. On the EngView Processes panel, click New Process . 

COMMENT: A new record — None Selected — appears in the table of processes. In this record we 
will specify the process. 

8. Click the None Selected box, and from the list that appears select your spot color from the Spot 
Color group. 

9. In the Ignore box of the Process column, click, and then, from the list that appears, choose Color 
Print. This is process that we will apply to chosen spot color. 

Creating finishing effects (processes) by layer 

We proceed by creating a foil printing finishing effect for the two elephant graphics. Because the 
objects are intentionally placed in a separate layer, we will do this by applying the finishing effect onto 
the layer that contains them. 
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1. On the EngView Processes panel, click New Process . 

COMMENT: A new record — None Selected — appears in the table of processes. In this record we 
will specify the process. 

2. Click the None Selected box, and from the list that appears select the layer Elephants. 

3. In the Ignore box of the Process column, click, and then, from the list that appears, choose Partial 
Foil Stamping. This is the process that we will apply to all objects in the Elephants layer. 

4. In the Type column, select Gold foil. 

 

 

NOTE ON THE USE OF BRAILLE TEXT 
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We can apply a Braille finishing effect. First, in a separate layer we use the Braille Regular font to write 
a text, and then we create a Braille process for that layer. 
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